
5 Installing Video Drivers

A README file is provided for each application driver in the Trident
installation disks.  These files summarize the latest product revisions,
contain directions for installation, and use of enhanced drivers.  After
their corresponding drivers are installed, you may load and print their
README files using any word processor.

Installation

This chapter provides instructions on the installation of the software
drivers supplied with the graphics accelerator board.  These software
drivers offer performance and quality improvements over the standard
graphics software drivers supplied with the computer system.  Drivers
extend the graphics capability for selected applications by offering
options such as increased screen size, color depth and monitor refresh
rates, as well as improving overall graphic performance.

Note:
To conserve hard disk space, install only the drivers you use.  You may
require application software disks during driver installation.
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Micr osoft Windows 3.1

The graphic installation program (TINSTALL) supports a simple 6 step
installation procedure for the display driver setup program, the power manage-
ment program and the UNinstall program.

To use TINSTALL, follow the 6 steps below:

1. Ensure MS Windows 3.1 is up and running properly, using the standard
VGA driver.

2. Select the MAIN group in Program Manager.

3. Click on FILE or press the <Alt> and <f> keys simultaneously.

4. Click on RUN or press <r> to select command line.

5. Type in A:TINSTALL (if the display driver disk is in the B drive then
type in B:TINSTALL) and then press <Enter> (Figure 5-1).

Figure 5-1  Running the TINSTALL Program

6. A menu will appear, offering a choice of Express or Custom Installation.

Express Installation
Express Installation is quick and decision free. Display drivers will be copied
into the TRIDENT.AGI directory and Utility files will be copied into the
TRIDENT.UTL directory.  Once all files are copied, a program group called
DISPLAY DRIVER AND UTILITIES will be created.
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Custom Installation
Custom Installation allows control over file storage and placement of icons.
The first dialog box which appears shows the where the drivers will be copied.
Click the CONTINUE button.  The next dialog box displays a summary of
where files are stored.  Select CONTINUE to copy the drivers and utilities
files.  When all files are copied, the program will present a choice of program
groups where the icons will be created.  Create a new group to place the utility
icons or select from preexisting groups (e.g. main, applications, accessories,
etc.).

When all necessary files are copied and a group name is selected, the Tinstall
program will create three icons:

a. Screen Control (used to configure display drivers).

b. DPMS (used for power management configurations).

c. UNinstall (used to delete the installed TRIDENT drivers).

Note:
Different “display driver set” versions cannot be installed to the same
directory name.  “Display driver sets” of the same version number ( e.g.
UA6.0 ) will replace the existing one.

SCREEN CONTROL

The Screen Control panel contains controls for setting screen resolution, color
depth, font size, refresh rates.  Not all combinations of screen resolution, color
depth, font size and refresh rate are attainable.

Screen Resolution
Screen resolutions of 640x480, 800x600, 1024x768, 1280x1024 or
1600x1200 can be selected by clicking next to the available options.  The
virtual screen size is automatically adjusted to be at least as large as the
selected screen resolution.

Color Depth
Color depths of 16, 256, 64K, or 16.7M colors can be selected by clicking
next to the desired option.  Color depth determines the number of colors that
may be simultaneously displayed on the screen.  The selected color depth
determines the possible resolutions.
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Font-size
You may choose between small, large, and extra large on-screen font sizes.
Depending on the resolution and monitor type, this option may not be avail-
able.

Refresh Rates
Available refresh rates are dependent on the selected color depth and resolu-
tion.  The “Back to Default” option is used to reset the refresh rate to the
factory default value.

Configuring the Display Driver

1. Select the color depth first (Figure 5-2).  If the current driver does not
support the  selected color depth, restart Windows.

2. Select the resolution.

3. Select the font size (if option is available).

4. Select the refresh rate.

5. Click on OK. If the current driver does not support the selected configura-
tion, restart Windows.

Note:
Hot Key Control should be enabled before going into advanced setup. There
is no virtual screen support for 16 colors. 1280x1024 is only available for 16
colors.
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Figure 5.2  Screen Control Menu

Advanced Features (Virtual Screen Control)

The advanced features of the program is accessed by pressing ALT + D or by
clicking on the box marked Advanced.

This action opens up an extension of the Main Panel which presents the
following features:

1. Hot Key selection. Enabling this function allows setting up predefined
key strokes achieve specific virtual screen related actions.

2. Turn On virtual screen.   This function allows the use of the predefined
virtual screen sizes.  The predefined virtual screen sizes are selected by
clicking next to available options.  The size of the available predefined
virtual screen is dependent on the selected color depth and resolution.

3. Customize Virtual screen area.  Selecting this feature opens up a new
screen titled Virtual Screen Advanced Settings.  The features presented
through this screen are as follows:

Standard display resolutions are 640x480, 800x600, 1024x768 or
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1280x1024.  The amount of display memory used depends on the
selected resolution and color depth.  For resolutions of 640x480,
800x600, and 1024x768, there is a substantial amount of display
memory left unused.  The Virtual Screen features take advantage of this
unused memory by “expanding” the display area into the off-screen
area.

Virtual Screen Control allows the user to make effective use of a display
screen larger than the standard 640x480, 800x600 or 1024x768, and the
standard resolution is the center of the screen.  The user can “pan”
around the larger Virtual Screen area by the using a standard mouse or a
set of “HOT KEYS.”  For example, it is possible to select a resolution of
640x480 and set the Virtual Screen size to 800x600.  Thus, the 640x480
screen sits at the center of a 800x600 matrix, and the user can “pan”
through the entire 800x600 matrix in a 640x480 window (Figure 5-3).

       

Panning allows traversing a larger screen through a smaller window.
  VIRTUAL SCREEN AREA   ACTUAL DISPLAY AREA

Figure 5-3  Virtual Screen Control

The advanced features provide functions to customize the virtual screen, as
shown in Figure 5-4:
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Figure 5.5  Virtual Screen Control Menu

Freeze Screen
The Freeze Screen option is used to disable the panning feature, giving the
illusion of a frozen screen but maintaining other virtual screen functions.  Hot
key functions are available for this feature.

Linear Frame Buffer Address
The Linear Addressing driver will automatically detect the system’s memory
size and sets the frame buffer to an unused area above the system memory. The
Linear Frame Buffer Address setting is useful in avoiding conflicts with
Windows applications which use the same linear frame buffer address as the
Display Driver. Addresses between 18 and 63 megabytes may be selected. If
there is no conflict, the default setting is highly recommended.

Border Space
The Border Space option is used to set up a border (thickness measured in
pixels) within the displayable Area, which is used as a marker for panning the
screen, i.e. when the cursor hits against this border, screen panning occurs
(Figure 5-5).
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Border space sets up a transparent border (black area) on the display area,
that is used as a threshold to start panning the virtual screen.

Figure 5-5  Border Space

Pan Set Hot Key
Hot keys may be set up to pan the virtual screen left, right, up and down. The
feature has to be enabled first by clicking on the ENABLE box, before hot
keys can be selected.

Once all selections are made, click on OK or press ALT + O to exit the
advanced setup.

DPMS (Display Power Management SIGNALING)
The Power Management program is designed for energy-saving monitors
which conform to the VESA Display Power Management Signaling (DPMS)
standard.

Warning:
The use of this program is not recommended for monitors that do not
support the VESA DPMS standard.

The program offers three power-down modes (Figure-5-6):

1. Standby (minimum power savings)
2. Suspend (substantial power savings)
3. Off state (maximum power savings)
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Figure 5-6  DPMS Menu

The program monitors for mouse and/or keyboard activity. When activity is
not detected for a specified delay period (controlled by the Delay Time
parameter), the program signals the TGUI9440AGi to enter the selected
power-down modes.

The Display Power Management program offers several options to customize
the DPMS operation:

Delay Time
The delay time to enter each mode may be set by entering the value (in
minutes) in the Delay Time parameters. Values can be entered by either
clicking on the count-up or countdown button, or by clicking on the number,
deleting it, and typing in the desired time in minutes (Figure 5-7).

Figure 5-7  Setting the Delay Time
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Activity Select
The Activity Select option may be set to sense mouse movement, keyboard
activity, or both.  For example: if both mouse and keyboard are selected, then
either activity will reestablish the powered down signals.

Password Option
The Password Option sets up a password to get back onto the screen.

A password is set up by first clicking on the box marked PASSWORD
PROTECTED or by pressing ALT + P (this is confirmed by the presence of an
“X” in the box).

Press ALT + S or click on the box marked SET PASSWORD.

Type in the selected password (twice) and select OK, or press <Enter>.

Clock
Turning on the clock enables the digital count down display.

Alarm
If the Alarm option is enabled, then the last 5 seconds of countdown to stand
by mode is synchronized with beeps from the PC speaker.

Startup On/Off
This option installs the Display Power Management program onto the Win-
dows Startup file, so DPMS is active upon entering Windows.

Default
The default button sets all parameters back to the factory default values.

Test
The test feature is used to give a demonstration of the DPMS power down
function.

Save
This feature is used to save all the current settings.  Once all settings are
selected, the program is activated by pressing ALT + O or by clicking on the
box marked Turn On DPMS.



Display Driver UNinstallation

The UNinstall program enables the user to safely delete specific display
drivers or an entire display driver set.

To remove an entire Display Driver Set, complete the following steps:

1. Using the arrow keys or mouse, select the desired Display Driver Set to be
removed (the set to be deleted should be highlighted).

2. Once the desired Driver Set is selected, click on the Delete button or
press <Enter>.

Note:
The UNinstall program will not permit the deletion of a Display Driver Set
that is currently used.

To remove an individual driver from a Display Driver Set, complete the
following steps:

1. Using the arrow keys or mouse, select the desired Display Driver Set to be
removed (the set to be deleted should be highlighted).

2. Once the desired Driver Set is selected, click on the Enter button. This
will pull up a list of available display drivers.

3. Select the display driver to be deleted by using the mouse or the up/down
arrow keys to scroll through the list.

4. Click on the Delete button or press ALT + D to delete the selected display
driver.

Installing Video Drivers
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Micr osoft Windows NT

Microsoft Windows NT 3.1

Installation
1. Run the Microsoft Windows NT Setup program located inthe Main group

of Program Manager.

2. Select “Change System Settings” from the “Options” pull-down menu.

3. Select “Other” from the display options.

4. Microsoft Windows NT 3.1 will prompt you for the path where the
Trident drivers are located. Enter the path “X:\TVGAUTIL\NTDRV\
NT31\”  where X is the drive where Disk 2 of the Trident Utility is
located.

5. A list of all Trident drivers will appear, select the resolution and color
depth desired.

6. Restart Microsoft Windows NT.  The desired Trident driver will then be in
effect.

Note:
If you select a color depth or resolution, not supported by your card, NT will
substitute 640x480, 256 color for the display.

Microsoft Windows NT 3.5

Installation
1. Run the Microsoft Windows NT display Setup program located in the

Control Panel of the Main group.

2. Select “Change Display Type...” button from the Display Settings options.

3. Select “Change...” button from the Display Type options.

4. Select “Other...” button from the Select Device options.

5. Microsoft Windows NT 3.1 will prompt you for the correct path where the
Trident drivers are located. Enter the path “X:\TVGAUTIL\NTDRV\
NT31\” where X is the drive where Disk 2 of the Trident Utility is
located.
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6. A list of all Trident drivers will appear, select the resolution and color
depth desired.

7. Restart Microsoft Windows NT. The desired Trident driver will be in
effect.

Note:
If you select a color depth or resolution, not supported by your card, NT will
substitute 640x480, 256 color for the display.

Utilities Installation

Installation Procedures

The Utility Installation program is used to install and retrieve instructions on
utility programs and non-Windows applications display drivers.

To run the utility programs, follow the steps below:

1. Insert the UA 6.0 disk # 2 in the floppy drive.

2. Type in README at the floppy drive prompt.

3. A numbered list of available destination drives will be displayed on the
screen. Select the destination drive by typing in the corresponding
number, e.g. to select drive C, type in 1.

4. Files and subdirectories will be expanded into the newly created directory
TVGAUTIL. A new menu will be displayed on the screen, showing a
list of on-line instructions.

5. Selecting A will display the contents of all drivers in the list.

6. Selecting B will display instructions on the available utility programs.

7. Selecting C will display instructions on how to install display drivers for
non-Windows applications.

Installing Video Drivers
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Utilities Summary

SVM.  EXE
SVM is a menu-driven program designed to select and test all video modes
available to the adapter.

How To Use SVM
The SVM program may be executed in either of two ways: by calling up the
menu and selecting from the menu choices, or by entering the desired mode
directly with a specific command line.

How To Use SVM From The Menu
1. Switch directory to “X:\TVGAUTIL\UTILITY” where X is the drive

where Disk 2 of the Trident Utility is located.

2. Type SVM to pull up the menu.

The top bar shows the available color depths. This is traversed through by use
of the right/left arrow keys.

The program provides all the different resolutions supported by the chip under
each color depth. These resolutions are traversed by the up/down arrow keys.

The graphics adapter can be tested for each resolution/ mode by first highlight-
ing the selection by use of the arrow keys, then pressing the <F5> key.

The graphics adapter can be run at a selected mode by first selecting the mode
and then pressing <Enter>.

How to Use SVM From The Command Line
The SVM program may be used to select a mode directly from the command
line following two steps:

1. Switch directory to “X:\TVGAUTIL\UTILITY” where X is the drive
where Disk 2 of the Trident Utility is located.

2. Type in SVM [mode number]<Enter>.

For example, to run the graphics adapter in mode 62H, the command for item
2 above would be:

svm 62 <Enter>.

Micronics LPX30WB System Board Manual

5-14



SMONITOR
SMONITOR is designed to set the monitor group and the monitor type:

smonitor <group|option> <Enter>

Set Monitor Group
The graphics extended modes set by the graphics card’s BIOS are sorted into
six groups categorized by the monitor’s refresh rate. The group setting as
below:

Resolution Group

0 1 2 3 4 5 6 7

640X400 70 70 70 70 70 70 70 70

640x480 60 60 75 85 95 95 95 95

800x600 56 60 75 75 85 85 95 95

1024x768 87i 87i 60 70 75 85 95 95

1280x1024 87i 87i 87i 87i 60 60 60 60

1600x1200 87i 87i 87i 87i 87i 87i 87i 87i

OPTION:
C SET COLOR MONITOR
M SET MONOCHROME MONITOR

Figure 5-8  Setting the Monitor Group

The default group number is 4.

If you want set the monitor group, type:

smonitor <group>

where <group> is one of the group number listed above.

Set Monitor Color
Switches between color and monochrome display. Some monitors (most
notably Samsung monitors manufactured before 2/8/91) do not adhere to the
standard IBM pinout definitions, which causes the VGA card to boot up in
monochrome instead of color. This utility may be used to correct the problem.

To set the monitor as color, type:
smonitor c

To set the monitor as monochrome, type:
smonitor m

Installing Video Drivers
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TVGACRTC
The TVGACRTC program allows the adjustment of video display parameters
so images are optimally sized and centered on the screen. Adjustable param-
eters include:

Horizontal size and position.
Vertical size and position.
Pixel frequency.

The program is started from the DOS prompt by typing in TVGACRTC from
the C:\TVGAUTIL\UTILITY directory.

The first section of the program is used to define a given name for the adjust-
ments to be made (Figure 5-9).

Table 5-9  TVGACRTC Menu

1. Press <Enter> to add a new monitor entry and type in the name of the
manufacturer, followed by <Enter> keystroke.  The program will allow
any name to be typed in.

2. Type in the associated comments for the monitor settings and press
<Enter>.

3. A mode table is displayed, presenting all the adjustable modes as
shown in Figure 5-10.
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Figure 5-10  TVGACRTC  Mode Table

4. This table is traversed through the use of the up/down arrow keys.  The
mode highlighted is the selected mode for adjustment.

5. Select the mode to be adjusted and press <Enter> (Figure 5-10).

6. Select the desired pixel rate by scrolling the list (Figure 5-11) using the
up/down arrow keys and press <Enter> twice.

Figure 5-11  TVGACRTC Pixel Rate Table

7. The screen alignment test pattern will be displayed.   The up/down
arrow keys are used to adjust the vertical positioning of the screen.  The
left/right arrow keys are used for horizontal alignment of the screen.  The
home/end keys are used for horizontal screen sizing and the page up/down
keys are used for vertical screen sizing.  Once the screen position and size
is adjusted, press <Enter>, followed by the ESC keystroke.

8. To save the settings, type Y and press <Enter>.  The program will modify
the config.sys file.

9. Press ESC and reboot the system to enable the parameter changes.

Installing Video Drivers
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Driver Installation

After selecting Drivers from the Main Menu, you are presented with a list of
possible drivers to install.  Select the desired driver.  A list of application
versions will appear.  Pick the appropriate version.  Once you have selected
the desired driver, the installation program will either provide you with further
instructions or guide you through the installation.  The following pages give
details for installing each available driver.

Lotus 1-2-3, versions 2.1 and 2.2

1. Copy the Lotus 1-2-3 driver into your Lotus directory by running
SET123 from the \TVGUTIL directory.  For example, if the driver/utility
is installed in the D: drive and Lotus 1-2-3 is installed in the C: drive with
directory name \LOTUS, type:

d:\tvgautil\set123 c:\lotus <Enter>

2. Change to the LOTUS 1-2-3 directory and type: LOTUS to open the main
menu.

3. Select Install from the main menu.

4. Select Advanced options from the Install menu.

5. Select Add new driver to library from the Advanced Options menu.

6. Select Modify current driver set from the menu.

7. Select either text or graphics display. For the text mode, choose one of the
following command lines to indicate the number of rows for your display:

TVGA 132x25 Version x.x
TVGA 132x30 Version x.x
TVGA 132x43 Version x.x
TVGA 132x60 Version x.x
TVGA 80x30 Version x.x
TVGA 80x43 Version x.x
TVGA 80x60 Version x.x

Example:
Enter TVGA 132x25 Version 1.0 for 132 column by 25 row display. The
following row values may be used: 25, 30, 43, or 60.
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For graphics mode, select the following command line:
TVGA 640x480 for Release 2.x

8. Return to the Lotus 1-2-3 main menu and choose Save Change to record
the changes, then exit the Lotus 1-2-3 installation program.

9. Installation is complete for Lotus 1-2-3. To reconfigure for a different
resolution (i.e. 132x25 to 132x30 in text mode), follow steps 3 through 8,
then run Lotus 1-2-3 as usual.

Symphony 2.x

1. Copy the Symphony driver to the \SYMPHONY directory by running the
SETSYMPH utility found in the \TVGAUTIL directory. For example, if
the driver/utility is installed in the D: drive and the Symphony application
is installed in the C: drive with a directory name \SYMPHONY, type:

d:\tvgautil\setsymph c:\symphony

2. The remaining steps need to be completed inside Symphony. Note them
down or reference steps 4 through 9.

3. Change to the Symphony 2.x directory and type: SYMPHONY to open
the main menu.

4. Select Install from the main menu.

5. Select Advanced options from the Install menu.

6. Select Add New Driver To Library from Advanced Options menu.

7. Select Modify Current Driver Set from the menu.

8. Select either text or graphics display. For the text mode, choose one of the
following command lines to indicate the number of rows for your display:

TVGA 132x25 Version x.x
TVGA 132x30 Version x.x
TVGA 132x43 Version x.x
TVGA 132x60 Version x.x
TVGA 80x30 Version x.x
TVGA 80x43 Version x.x
TVGA 80x60 Version x.x
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Example:
Enter TVGA 132x25 Version 1.0 for 132 column by 25-row display. The
following row values may be used: 25, 30, 43, or 60.

For graphics mode, select the following command line:
TVGA 64Ox480 for Release 2.x

9. Return to the Symphony main menu and choose Save Changes to record
the changes, then exit the Symphony installation program.

10. Installation is complete for Symphony.  To reconfigure for a different
resolution (i.e. 132x25 to 132x30 in text mode), follow Steps 4 through 9,
then run Symphony as usual.

GEM Desktop 3.xx

1. Follow the prompts to prepare a GEM/3 driver diskette.  The installation
program will copy driver files to the newly formatted diskette in drive A:.

.
2. The remaining steps need to be completed in side GEM.  They are listed

in a text window.  Note them down or reference steps 3 through 7.

3. Insert original GEM/3 system Master Disk and run “GEMSETUP”.

4. Select in order Change Existing Configuration, Continue, Change Your
Current Setup, and the listed graphics and card display.

5. When prompted for a new graphics card and display, select Other Pack
and insert the newly prepared GEM/3 driver diskette in drive A:.

6. Select a display driver.

7. Continue with the rest of the GEMSETUP program. Please consult your
GEM manual for more information on the GEMSETUP program.

Ventura Publisher

1. Follow prompts to prepare a Ventura driver diskette. The installation
program will copy driver files to the newly formatted diskette in drive A:.

2. Supply the location of the Ventura directory on the hard disk when
prompted (e.g. C:\VP). Enter the path and then select OK.
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3. Indicate whether or not the Ventura Publisher Professional Extension is
being used.

4. Select one of the display modes listed.

5. Indicate the type of mouse being used and to which I/O port (i.e. COM1,
COM2, etc.) the mouse is connected.

6. Confirm choices to complete the installation.

Note:
To reconfigure for a different display mode, repeat this entire installation
procedure.

WordPerfect

WordPerfect 5.1

To Install the Text Mode Drivers
1. Copy the driver files from \TVGAUTIL\WP51 directory on your hard

disk drive into your WordPerfect 5.1 directory (e.g. C:\WP51).  For
example, if WordPerfect 5.1 is to be installed in drive C: and the
driver\utility is installed in driver D:, type:

copy d:\tvgautil\uf51\tvgatext.vrs c:\wp51 <Enter>

The display drivers (TVGATEXT.VRS) will be copied automatically to
the WordPerfect directory.

2. The remaining steps need to be completed inside WordPerfect. They are
listed in a text window.  Note them or reference steps 3 through 5.

3. Run WordPerfect 5.1 by typing WP at the WordPerfect 5.1 program
directory.

4. Press Shift-Fl to bring up the Setup Menu. Press “2” to select Display and
“3” to select Text Screen Type.

5. Choose one of the extended text drivers. The available drivers are 80x30,
80x43, 80x60, l32x30, 132x43, 132x60.

6. Driver installation is complete for WordPerfect. To reconfigure for a
different resolution (eg. 132x25 to 132x30 in text mode), repeat steps 4
and 5.
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To Install Extended Graphics Mode Drivers
1. Copy the driver files from \TVGAUTIL\WP51 directory on the hard disk

drive into the WordPerfect 5.1 directory (e.g. C:\WP51). For example, if
WordPerfect 5.1 is installed in drive C: and the driver\utility is installed in
drive D:, type:

copy d:\tvgautil\wp51\tvga16.vrs c:\wp51

The display drivers (TVGA16.VRS) will be automatically copied to the
WordPerfect directory.

2. The remaining steps need to be completed inside WordPerfect. They are
listed in a text window.  Note them or reference steps 3 through 5.

3. Run WordPerfect 5.1 by typing WP at the WordPerfect 5.1 program
directory.

4. Press the <Shift-Fl> to bring up the Setup Menu. Press “2” to select
Display and the “2” to select Graphics Screen Type.

5. Choose one of the Extended Graphic drivers. The available drivers are
800x600-16 colors, 1024x768-16 colors, and 768xl024-16 colors.

6. Driver installation is complete for WordPerfect. To reconfigure for a
different resolution (eg. 800x600), repeat steps 4 and 5.

WordPerfect 6.0

To Install the Text Mode Drivers
1. Copy the driver file from \TVGAUTIL\WP60 directory on the driver into

the WordPerfect 6.0 directory (e.g. \WP6.0). For example, if WordPerfect
6.0 application is installed in drive C: and the driver\utility program is
installed in drive D:, type:

copy d:\tvgautil\wp60\tvga6txt.vrs c:\wp60

2. To run WordPerfect 6.0 from the directory, type WP.

3. Make sure WordPerfect 6.0 Text Mode is selected. A check mark or an
asterisk should appear in front of “Text Mode” under the View pull-down
menu.

4. Select the “Setup” option under the File pull-down menu, and chose
Display. Select “2. Text Mode Screen Type/Colors” and then select
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“Screen Type”.  To install the Trident driver, select “Trident VGA”. Select
the appropriate screen resolution.

To Install Extended Graphics Mode Drivers
WordPerfect 6.0 for DOS allows selection of Text Mode or Graphic Mode
Interface. For graphic mode, install the VESA driver and select a resolution
from 640x480 to 1024x768.

1. If the VGA BIOS on the card is version C3.0 or later, select the VESA
driver that is included in the WordPerfect 6.0 program. If the VGA BIOS
is a version earlier than C3.0, run the VESA.EXE utility program located
on the VGA Driver/Utility diskette. Please see section on SMONITOR in
the Utility section earlier in this chapter.

2. Make sure the VESA driver from WP6.0 installation program is selected
and installed. Boot-up the WordPerfect 6.0 program and select “Graphic
Mode” from the view pull-down menu.

3. Select “Setup” from the “File” pull-down menu. Select “Display”, and
choose “1” to select the different graphic mode driver. Choose “1” for
Screen Type. Highlight “VESA VBE” and select the desired resolution.
Follow the instructions on the screen to complete installation.
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Micr osoft Word for DOS

MS Word 5.0

1. Copy the MS Word driver from the \TVGAUTIL\Word directory on the
hard drive into the MS Word 5.0 directory (e.g.\Word50). For example, if
MS Word 5.0 is installed in drive C: and the Driver/Utility is installed in
drive D:, type:

copy d:\tvgautil\word\screen.vid c:\word50

Note:
The display drivers (SCREEN.VID) will be automatically copied to the Word
directory.

2. The remaining steps need to be completed inside MS Word.  They are
listed in a text window. Note them or reference steps 3 through 5.

3. Run MS Word 5.0 by typing “ WORD” in the MS Word 5.0 directory.
4. Press <Esc> to enter a command. Press <o> to enter an Option Command.

5. Select Display Mode, then press F1 to list the display modes available.
Choose one of the following lines to indicate the number of rows for the
display:

(1) Text, 25 lines, 16 color (5) Text, 25 lines, 16 color1

(2) Text, 43 lines, 16 color (6) Text, 30 lines, 16 color1

(3) Text, 50 lines, 16 color (7) Text, 43 lines, 16 color1

(4) Text, 60 lines, 16 color (8) Text, 60 lines, 16 color1

1 Lines 5 through 8 are for 132 column modes.  Mouse support is not available
for 132 column modes.

6. Driver installation for MS Word is complete.  To reconfigure for a
different resolution (i.e. 132x25), repeat steps 4 and 5.

MS Word 5.5

1. Change the directory to \TVGAUTIL\Word55.

2. Type SETUP to run the setup program.  Follow the instructions on the
screen to complete the driver installation.
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Panacea AutoCAD TurboDLD Driver

TurboDLD Classic Driver by Panacea is a combined display interface and
rendering driver. It supports DOS versions of AutoCAD 10/386, 11/386, and
12.  It offers the following resolutions for the drawing editor :

640x480 16 colors
800x600 16 colors
1024x768 16 colors
1280x1024 16 colors
320x400 200 colors
640x480 256 colors
800x600 256 colors
1024x768 256 colors (1MB Video RAM required)
1280x1024 256 colors (2MB Video RAM required)
512x480 32k colors
640x480 32k colors
800x600 32k colors
512x480 65k colors
640x480 65k colors
800x600 65k colors

It also offers the following resolutions for rendering:

320x200 256 colors
640x480 256 colors
800x600 256 colors
1024x768 256 colors (1MB Video RAM required)
1280x1024 256 colors (2MB Video RAM required)
512x480 32k colors
640x480 32k colors
800x600 32k colors
512x480 65k colors
640x480 65k colors
800x600 65k colors

To install the display drivers for AutoCAD 10/386, 11/386 or 12.  The UG6.0
DISK # 2 and the proper AutoCAD 386 Release is required.

Important:
Ensure AutoCAD is already installed with the IBM Standard VGA driver.
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AutoCAD/386 Release 10 and 11

1. Change the directory to C:\TVGAUTIL\ACAD. Type INSTALL [enter]
and follow the installation steps on the screen. The TurboDLD Classic
Driver and the other files will be copied to the proper ACAD working
subdirectory.

2. Run DLD386’s FASTCAD.BAT or copy the commands from the file into
the AUTOEXEC.BAT file before running AutoCAD.  FASTCAD.BAT
sets the environment variables including DLDCFG, DSPADI, RDPADI
and RCPADI.

3. Start AutoCAD/386 and select Configure AutoCAD from the Main Menu.

4. Select Configure, Video, Display.

5. Select ADI P386 v4.0/4.1 display. This will pull up TurboDLD’s configu-
ration menu, which should be used to select the desired graphics board
resolution.

6. Select the graphics area background color, text color (for the menu status
line and command prompt areas of the screen), text background color,
border color, and dialog box/button outline color. To select the default
colors, press <Enter> at each prompt. To select a different color, enter
the desired color number at the given prompt.

AutoCAD/386 Release 12

Display Driver Installation Procedure
Change the directory to C:\TVGAUTIL\ACAD and type INSTALL <Enter>.
Follow the installation steps on the screen. The TurboDLD Classic Driver and
the other files are copied to the proper ACAD working subdirectory.
The display driver for the drawing editor and rendering is installed by follow-
ing these steps:

Editor Installation Procedure
1. Run the AutoCAD Drawing Editor screen.

2. Select CONFIGURE in the File pull-down menu.  AutoCAD will switch
to a text screen.

3. Select 3 to configure the video display. AutoCAD will then show the
current video display.
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4. Select “Y” to select a different driver.

5. Select “Trident Microsystems Panacea, Inc.”. This will bring out the
TurboDLD’s configuration menu.

6. Follow the menu to select the desired resolution.

7. Save the selection and exit from TurboDLD’s configuration.

8. Enter “0” to return to the Drawing Editor screen.

9. Answer “Y” to save configuration changes.

Rendering Installation Procedure
1. Ensure Rendering for AutoCAD Release 12 is already installed.

2. Select Preferences in the Render pull-down menu from the Drawing
Editor screen.

3. If Rendering has been previously configured, select Reconfigure in the
Rendering Preferences dialog box. Otherwise, the program automatically
will switch directly to a text screen.

4. Select “2” to configure the rendering driver.

5. Select “AutoCAD’s configured P386 ADI combined display/rendering
driver.”

6. Select the desired resolution for rendering.

7. Select the desired rendering view.

8. Enter “0” to return to the Drawing Editor screen.

9. Answer “Y” to save configuration changes.

10. Click OK to close the Rendering Preferences dialog box.
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Quattro Pro 2.x for DOS

1. Copy the Quattro Pro driver from the \TVGAUTIL\PRO directory on the
hard drive into the QPRO 2.x for DOS directory. For example, if your
Quattro Pro 2.x is installed in drive C: and the Driver/Utility is installed in
drive D:, type:

copy d:\tvgautil\qfro\video.rsc c:\qpro

Note:
The display drivers (VIDEO.RSC) will be automatically copied to the Quattro
Pro directory.

2. The remaining steps need to be completed inside Quattro Pro. They are
listed in a text window. Note them or reference steps 3 through 5.

3. Choose to run Q.EXE by entering “Y” in response to the prompt. The
Driver/Utility Installation program will exit to Quattro Pro.

4. Press “O” to select the Options menu and “D” to select Display Mode.

5. Choose an extended text mode.

6. The graphic driver installation for Quattro Pro is complete.  To
reconfigure for a different resolution (i.e. 800x600), repeat steps 4 and 5.
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